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February 1, 2019
Legislative Reference Library
645 State Office Building
100 Rev. Dr. Martin Luther King Jr. Blvd.
St. Paul, MN 55155
Dear Sir or Madam,
Enclosed please find (2) two hard copies of a report required by Minnesota Statutes § 2017
Minnesota Session Law, Chapter 89, Article 1, Section 3 concerning Minnesota State Senior
Care Career Awareness Campaign offered by Minnesota State. Copies of this report, “2018
Senior Care Career Awareness Campaign: Report to the Legislature,” were delivered to The
Honorable Tim Walz, Governor of State of Minnesota; Representative Connie Bernardy, Chair of
the Higher Education Finance & Policy Division Committee; Representative Bud Nornes, Ranking
Minority Member of the Higher Education Finance and Policy Division; Senator Paul Anderson,
Chair of the Higher Education Finance & Policy Committee; and Senator Gregory Clausen,
Ranking Minority Member of the Higher Education Finance & Policy Committee.
Please contact me, mary.rothchild@minnstate.edu if you have any questions or concerns.
Sincerely,

Mary Rothchild, Senior System Director for Workforce Development
c:

Ron Anderson, Senior Vice Chancellor for Academic and Student Affairs
Melissa Fahning, Government Relations

February 1, 2019
HealthForce Minnesota/Winona State University

Legislative Report:
Senior Care Career
Awareness Campaign
Minnesota State

Legislation Session Law 2017 Chapter 89, Article 1, Section 3

The Minnesota Legislature appropriated $100,000 in fiscal year 2018 for Winona State University to fund
HealthForce Minnesota’s development of educational materials that increase awareness of career
opportunities available in the field of senior care. The legislative language is below:
$100,000 in fiscal year 2018 is for use by Winona State University for
HealthForce Minnesota to develop educational materials that increase
awareness of career opportunities available in the field of senior care. The
educational materials developed under this provision must be appropriate for
students in K-12 education settings, dislocated workers, and rural communities.
Materials must be developed in collaboration with employers and trade
organizations representing employers in the field of senior care. Winona State
University shall submit a report by February 1, 2019, to the chairs and ranking
minority members of the legislative committees with jurisdiction over higher
education finance and policy. The report must include information about the
materials developed, to whom materials were distributed, and identify any
collaborations with employers and trade organizations.

Background

Hosted by Winona State University, HealthForce Minnesota is one of Minnesota State’s eight industry
sector-focused Centers of Excellence. Each of the Centers of Excellence harnesses energy, expertise,
and resources for its respective sector to ensure that Minnesota employers have a robust and
appropriately trained workforce to meet current and future workforce needs. HEALTHFORCE
MINNESOTA has a long history of collaboration and partnerships with Minnesota’s healthcare
employers, associations, educators (both public and private), and state agencies. When the Long-term
Care Imperative began exploring the concept of a Senior Care Career Awareness Campaign, HealthForce
Minnesota was seen as a natural fit to lead the campaign based on several factors:
1. Extensive involvement in both Care Providers of Minnesota and LeadingAge Minnesota’s
workforce committees and councils
2. A history of successful partnership with these associations and many others in achieving
workforce development initiatives
3. Expertise in project management and leadership of large, complex, and multi-faceted
initiatives
4. An understanding of the challenges facing senior care service providers
5. HealthForce Minnesota’s reputation as a neutral, objective, and well-respected organization
that acts in the public interest
6. Consistency with the well-established Tour of Manufacturing – a similar concept in a
different industry – that is led by the Minnesota State Advanced Manufacturing Center of
Excellence
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Approach

Following discussions with leadership and staff of LeadingAge Minnesota and Care Providers of
Minnesota, HealthForce Minnesota created an advisory committee that included representatives from
both associations. The advisory committee met several times by conference call and communicated
through email. Key staff from LeadingAge and Care Providers were frequently tapped for feedback and
ideas.
HealthForce Minnesota Executive Director, Valerie DeFor, presented on the project at many meetings
and events – a strategy that served to increase awareness of the need. These meetings, advisory
committee engagement, and many discussions forged a strategy and overall direction for the campaign
initiative. A consensus emerged that a website would be the most practical vehicle to reach key
audiences. In addition, a social media campaign was envisioned which would more directly resonate
with high school and college students.
Early on, HealthForce Minnesota identified the opportunity to utilize students at Winona State
University to design parts of the campaign. The use of students who understand the language,
motivations and interests of the target audience became an innovative approach to the development of
the campaign.
A marketing and communications Request for Proposals was submitted to the state register, yielding
three proposals. The advisory committee reviewed the proposals and selected a vendor.

Use of Students
Recognizing that college-age students are one of the key audiences for the campaign, HealthForce
Minnesota asked Winona State University Marketing faculty if there were any opportunities to integrate
the senior care campaign into course work. Dr. Michael Behan readily embraced this opportunity and
used it in the capstone marketing class at Winona State University in the Fall of 2017. Ms. DeFor
presented to the class, sharing data about the workforce need in senior care services and relayed the
key challenges in recruiting and retaining workers in this field. Students then formed eight groups and
each group created a marketing campaign. Students presented to several members of the advisory
committee. This resulted in eight different proposed campaigns which led to greater insight into the
youth demographic and propelled the marketing campaign forward.
In the Spring of 2018, Dr. Robin Saner’s graduate level school counseling class also adopted the senior
care campaign platform and used it to create lesson plans for grades K-11. The lesson plans were tied to
Minnesota school standards and were designed to be “turn key” for use by school counselors and
teachers. The lesson plans will be housed on the HealthForce Minnesota website, the campaign
website, and the Minnesota School Counselors Association website. The modules were shared at the
Minnesota School Counselors Association conference in May of 2018.
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In the summer of 2018, Ms. DeFor worked with three Minnesota State University, Mankato students
who applied to be interns on this project. The three students each developed content for a component
of the senior care campaign.
Using students judiciously in the project not only provided vital insight and creativity, but also engaged
approximately 50 students in the challenges and opportunities of the senior care sector. It is likely these
students told friends about their assignments so that the campaign reached students even before it
officially began.
In addition to utilizing college/university students in the early stages of the campaign development,
middle and high school students were reached through the 15 Scrubs Camps that HealthForce
Minnesota offers throughout the state. The theme of the 2018 Scrubs Camps was “Senior Care” and
each of the fifteen camps showcased occupations related to the theme. Many camps had site visits to
nursing homes. These site visits ranged from participating in a picnic with residents of Samaritan
Bethany in Rochester to touring Augustana in Minneapolis, to engaging in social activities with residents
of Good Samaritan Homes in Brainerd. Through Scrubs Camps, approximately 850 middle or high school
students learned about the importance of caring for seniors and the many job opportunities in this field.

The Campaign

Working with the marketing students’ plans as a starting point, a campaign name and theme was
developed.

Combining “Explore” with “Senior Services” is an active and engaging way of encouraging students and
adults to learn more. “Caring Careers Start Here” is the tagline by which the campaign will be best
known. This capitalizes on the aspect of caring that is needed to work in the healthcare field in general,
and with seniors in particular. “Careers” elevates the field and allows us to highlight the many health
career pathways that can start with working in a nursing home or assisted living at an entry level as a
nursing assistant or aide. The tagline as a whole conveys a message that will resonate with anyone
thinking of a future in health care who wants to know where to start. We hope that “Caring Careers
Start Here” will be as well-known as manufacturing’s “Dream It. Do It.”
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Components
There are 3 primary components to the campaign – all of which will be supported by web resources on
the https://caringcareersstarthere.com website:
1) Open Hearts, Open House
2) Heart 2 Heart
3) Career Exploration

Open Hearts Open House
The first component is in the stage of “soft roll-out” with our request to
senior care providers to use the Open Hearts, Open House logo and branding
in association with a community engagement event to be held between
December 2018 and May 2019.
Through Open Hearts, Open House events, senior care providers are able to exhibit warmth and
caring as the cornerstone of the services each provides, as well as highlighting volunteer and
employment opportunities. This approach allows senior care providers to correct
misperceptions about the field and to highlight the many positive attributes of working with
seniors. This is a similar approach to the “Dream It. Do It.” campaign in which manufacturers
counter perceptions that they are noisy, dirty, and physically demanding places to work by
inviting community members into the facilities to see that the manufacturer of today is more
often a clean, high tech enterprise. The goal of Open Hearts, Open House is to showcase the
warmth, caring, and technology that represents today’s senior care environment.
Materials associated with the Open Hearts, Open House component are accessible via the
website which contains a downloadable Open Hearts, Open House tool kit which includes
descriptions, logos, flyer and sign templates, press release template, and a list of possible
events. These materials are provided as Attachment A.
In December 2018, senior care providers were asked to report events or planned events to
HealthForce Minnesota via an online survey. The survey also allows HealthForce Minnesota to
compile and share events via social media and website postings and to facilitate identification
and dissemination of best practices. To date, we have had responses from 8 senior care
organizations regarding plans to host an Open Hearts, Open House event in the upcoming
months. We will be reminding providers about the open house component periodically and
continuing to monitor and support these events.

5

In 2019, one week will be identified for a statewide Open Hearts, Open House initiative. During
this week, senior care providers will hold events throughout the state, elevating the campaign to
increase media coverage.

Heart 2 Heart

Recognizing that a key audience for future workforce development is youth,
the Heart 2 Heart component of the Caring Careers Start Here campaign
focuses on intergenerational activities. Through Scrubs Camps, HealthForce
Minnesota has seen how middle and high school students are able to interact
with seniors – we see “hearts open” at every event. Students who have never
been in a nursing home find the experience to be quite moving. This is consistent with
discussions held at both LeadingAge and Care Providers workforce meetings; there is a certain
percentage of people who really resonate with working with seniors. It is important to widen
the funnel so that those who would thrive in that environment are aware of it.
The Heart 2 Heart component will include a tool kit for senior care providers to work with a K-12
school or other organization in an intentional way. At the highest level, this might include a care
center and an elementary school forging a two-way partnership where each organization is a
priority for the other when opportunities for external partnership arise. For example, when the
2nd grade class is doing an art project, the projects could be displayed at the care center; the 5th
grade English class might interview residents of the care center and write their biography; care
center residents might serve as reading buddies for 3rd graders. The opportunities are endless.

Social Media

The Caring Careers Start Here campaign will include a social media component
to support, enhance, and complement the other components, as well as to
engage and energize individuals who might not be reached directly by the Open
Hearts Open House or Heart 2 Heart. Aspects of the social media campaign will
include photo contests, prizes for interacting with the post/tweet, and publicity tied to existing
“National ___ Day” (grandparents, nursing assistant, etc.). The social media campaign will also
leverage existing senior care-related messaging such as FaceAging MN.

In 2019, a student intern will be employed by HealthForce Minnesota to run the social media
component across Facebook, Instagram, Twitter, and Snapchat. We will also explore placing ads
on music streaming sites. As one of the Winona State University marketing student groups
reported “We listen to music and don’t have money to pay for no ads.”
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Career Exploration

A key feature of the Caring Careers Start Here website will be a section focusing on career
exploration. This page will feature:
•
•
•

Links to existing high-quality career exploration resources and websites
including LeadingAge Minnesota, Care Providers of Minnesota, Minnesota
Home Care Association, Minnesota State’s CAREERwise website, etc.
Location maps of senior care providers so that users can find the nearest
providers
Information on scholarships, tuition assistance, and loan forgiveness programs

The page will also feature new content including:
•
•
•

vignettes from senior care employees describing their jobs
a video showcasing the importance of caring for seniors
photos and captions from Scrubs Camps, Open Hearts Open Houses, and
Heart2Heart events

Budget Report

Note that neither Winona State University nor HealthForce Minnesota used any of the $100,000
allocated for this initiative to cover internal expenses.
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Item
Marketing and Website
contract with outside
vendor

Amount
$67,000

Student Interns – Summer
2018
Video Creation
Social Media Intern
Collateral Materials

$3,000

Other/Miscellaneous

$7,500-$10,000

$10,000
$5,000-$7,500
$5,000

Note
The Design Company has worked with many state
agencies and Minnesota State organizations.
Completion of additional webpages is included in
this contract.
MSU Mankato students worked on specific
components of the campaign.
To be created over the next 6 months.
A search will commence Spring 2019.
Social media prizes/giveaways, mailing to postsecondary students in health fields, magnets, etc.
New ideas to supplement the campaign, billboard
or signage targeting college/university students,
travel costs associated with sharing the campaign
at statewide meetings, materials for workforce
centers to showcase senior care jobs,
maintenance

Summary

HealthForce Minnesota was honored to lead the creation of a senior care career awareness campaign.
We were pleased to incorporate the use of university students into this initiative. We tapped the
knowledge and experience of passionate and innovative employers. The final product will be an
engaging and powerful mechanism to increase awareness of careers in senior care services among all
age groups. The website and social media approach ensure that the campaign is accessible to all regions
of Minnesota – urban and rural alike.

8

ATTACHMENT A
SENIOR CARE CAMPAIGN LAUNCH

Caring Careers Start Here
HealthForce Minnesota
LeadingAge Minnesota

Care Providers of Minnesota

Valerie DeFor / Executive Director
HealthForce Minnesota
vdefor@winona.edu

Thanks to the efforts of the Long-term Care Imperative, HealthForce Minnesota was given funding
from the State of Minnesota to create a senior care career awareness campaign, “Caring Careers
Start Here.” This initiative is designed to show students and adults that working in senior care is
not only financially and emotionally rewarding — but also offers opportunities for scholarships
and career advancement. A website is under development that will allow students to find work
and explore career paths in healthcare and provide employers access to curriculum and tools for
event planning, community building and education. While the full site is under construction, we’re
inviting you to begin a soft-roll out of the Caring Careers Start Here campaign by hosting an
event called:

Open Hearts • Open House
Events to Connect Caring Communities and Our Senior Citizens
Open Hearts Open House events are a great way to connect your seniors with the
neighboring community — and transform guests into future employees.
We encourage you to host one or more Open Hearts Open House events and submit your
survey before January 10, 2019. These events will not only add joy to the holiday season but
prepare you to maximize the benefits of the Caring Careers initiative for your organization.
Hosting an OHOH Event.
This OHOH Event Toolkit
will provide the basic
tools you’ll need to host
Open Hearts Open House
events between now and
January 10th. This kit also
includes a media kit of
photos and OHOH logos
for use in your own event
promotion (your newsletter,
your website, social media,
etc.).

Complete a Survey
Please take 10 minutes after
each event to complete a
survey that will ask how
many people attended,
what activity was done,
site information, and any
suggestions for improvement.
Please complete before
January 10, 2019 to be
included in a February report
to the Legislature. (https://
winona.az1.qualtrics.com/jfe/
form/SV_5AWiBqTSCOAN7iR)

Sign Up for Updates

If you’d like information
about upcoming events,
best practices in recruiting
and retaining millennials
and success stories from
communities around
Minnesota, please add
your information on our
MailChimp sign up form ...
http://eepurl.com/dMeNn6

Tool Kit Contents:

Intergenerational Activity Suggestions
Description:
This is a PDF list of possible activities to include in your Open Hearts Open House 		
			
event.
Instructions
Choose one or more based on your guest list and your facility’s residents. Gather the
				
necessary items and designate someone in charge to coordinate the activity.
Sample Press Release
Description:
Use this customizable MSWord press release to promote your event in local papers 		
			
and on your website. It is formated in the conventional press release style and offers
			
suggestions for content.
Instructions
Instructions for customizing this file is appears on the next page. You must have
				
MSWord on your system.
Flyer/Invitation Templates
Description:
These flyer/invitation/poster templates can be printed for
				
mailing or hanging. It can also be emailed and/or
				
uploaded onto social media.
Instructions
It is available as a MSWord doc. Instructions for customizing
				
the file appear on the next page. You must have MSWord
				
on your system.
Small Sign Templates
Description:
11 x 8.5 sign templates for use in lobby and indoor areas
Instructions
It is available as a MSWord doc. Instructions for
				
customizing the file appear on the next page.
				
You must have MSWord on your system.
Yard Sign Templates
Description:
Larger (24 x 18) signs for use in lobby and outdoor
				areas
Instructions
This file is available as an Acrobat PDF and is
				
customizable in Acrobat Pro or Acrobate Reader.
				
Instructions for customizing this file appears
				
on the next page. You must have either Acrobat
				
Pro or Acrobat Reader on your system. You can
				
download Acrobat Reader free at
				
https://get.adobe.com/reader/otherversions/

Open Hearts • Open House
Sample text … Join us at [Name of Facility] on [DATE]
from [TIME]. Meet our senior residents and visit our
welcoming facility!
Sample text … It’s truly open to all — whether you need
seniors to volunteer … or are looking for a job where you can
make a real difference in people’s lives … or simply want an
afternoon of fun, activities and refreshments.
Sample text … Heart healthy, heart warming activities,
including:

• [Name of activity] • [Name of activity]

[STREET ADDRESS] / [CITY, STATE ZIP]
[WEBSITE/PHONE/EMAIL] FOR MORE INFORMATION

Organization name or
logo stamp
Caring careers start here
EXPLORE SENIOR SERVICES Sponsoring Partners:
LeadingAge Minnesota • Care Providers of Minnesota • HealthForce Minnesota

Open Hearts • Open House

Join us today!

... just for the fun of it!
[Organization name or logo]

Caring Careers Start Here
EXPLORE SENIOR SERVICES Sponsoring Partners:
LeadingAge Minnesota • Care Providers of Minnesota • HealthForce Minnesota

Instructions for Customizing PDFs and MSWord Docs (see next page)

Media Kit Contents:

OHOH Photo images
Description:
Three images are available for your in use newsletters, website and social media.
				
It is also recommended to include a media kit with your press release.
Instructions
Two versions are available: for web and for print.
OHOH brand images
Description:
OHOH and Caring Careers logos are available to insert into your promotional 			
			
materials. It is also recommended to include a media kit with your press release.
Instructions
Two versions are available: for web and for print, with and without text.

Instruction for Customizing PDFs and MSWord Docs:
The Press Release, Flyer/Poster and Small Sign files are available as MSWord Docs which are
customizable if you have MSWord. The Yardsign is a PDF file, also customizable if you have Acrobat
Pro or Acrobat Reader, however it may be easier to have your sign printer customize it for you. 		
(Download Acrobat Reader free at https://get.adobe.com/reader/otherversions/)
Specific areas of each document are available for customization:

Open Hearts • Open House
Sample text … Join us at [Name of Facility] on [DATE]
from [TIME]. Meet our senior residents and visit our
welcoming facility!
Sample text … It’s truly open to all — whether you need
seniors to volunteer … or are looking for a job where you can
make a real difference in people’s lives … or simply want an
afternoon of fun, activities and refreshments.

Open Hearts • Open House

Join us today!

<< Customizable text >>

... just for the fun of it!
[facility name or logo stamp]

Sample text … Heart healthy, heart warming activities,
including:

• [Name of activity] • [Name of activity]

[STREET ADDRESS] / [CITY, STATE ZIP]
[WEBSITE/PHONE/EMAIL] FOR MORE INFORMATION

<< Customizable text or image >>

Caring Careers Start Here

Facility name or logo
stamp
Caring careers start here

EXPLORE SENIOR SERVICES Sponsoring Partners:
LeadingAge Minnesota • Care Providers of Minnesota • HealthForce Minnesota

EXPLORE SENIOR SERVICES Sponsoring Partners:
LeadingAge Minnesota • Care Providers of Minnesota • HealthForce Minnesota

Instructions for Customizing MSWord Docs
Open the MSWord doc. It works best if you click directly onto the text you wish to change and
start typing; DO NOT highlight the entire block text, and DO NOT copy and paste text from another
document. Once you are done editing, delete unwanted any characters. The areas for text are
predetermined and limited, so you will need to write text to fit. If the font changes, please reset
“Calibri” for brand consistency.
In the area for Customizable “Organization text or Image” you have a choice of text or image. If you choose
text, simply customize the text as described above. If you prefer to put your logo image, click and
highlight the text and delete it. Place your curser where you would like your logo and go to “Insert >
Pictures > Picture from file” ... find your logo and insert. Resize as needed. Go to “File > Save” and voila!
Instructions for Customizing PDFs
Open the PDF file in Acrobat Pro or Reader (download Acrobat Reader free at
https://get.adobe.com/reader/otherversions/). If the customizable text areas
are tinted, go into “Preferences > Forms” to deselect “Show border hover color
for fields.” Returning to your pdf, click and highlight the text you wish to
change and type new text. The areas for text are predetermined, limited and
cannot be changed, so you will need to write text to fit.
In the area for Customizable “Organization text or Image” you have a choice of text or image. If you choose
text, simply customize the text as described above. If you prefer to put your logo image, click and
highlight the text and delete it. Now go to “Tools” ... select “Stamp” ... select “Custom Stamp > Create”
... you can now browse to find your organization’s logo. Select it and hit “OK.” You will be asked to give it
a “category” (i.e. “Logo” ... giving it a “name” is optional) and hit “OK” ... then go to “Stamps Palette
> Logo (or the “category” name you just gave it)” and select your image. It will now appear on the
screen; move it to the bottom left of the document and click to place it (if you place it in the same
location of the original text box, it will be inaccessibly covered by the text box). Adjust the image size
using the corner markers and now move it to the original text location. Go to “File > Save” and voila!

Open Hearts • Open House

Join us today!

... just for the fun of it!
[organization name or logo
stamp]

Caring Careers Start Here
EXPLORE SENIOR SERVICES Sponsoring Partners:
LeadingAge Minnesota • Care Providers of Minnesota • HealthForce Minnesota

Caring Careers Start Here
[Organization name or logo
stamp]
Sponsoring Partners:		 Leading Age Minnesota • Care Providers of Minnesota • HealthForce Minnesota

Open Hearts • Open House

Join us TODAY!

... just for the fun of it!

Open Hearts • Open House
Intergenerational Activity Suggestions for Open Hearts Open House Events
General Categories

•

Healthy Living/Exercise: Zumba/Dancing, Yoga, Baseball, Walking, Share Recipes,
Healthy Cooking, Exercise Classes, Balloon Badminton, Noodle ball

•

Arts/Crafts: Karaoke, Poetry, Theatre, Painting, Birdhouse, Watercolor, Clay, Baking,
Cookie Decorating, Friendship Bracelets, Tie Dye T-shirts, Sign Making, Card Making,
Personal Planters, Book Reading, Beadwork, Button Design Contest, Specialized
Holiday Activities, Sing Along, Scrapbooking, Knitting

•
•

Outdoor Activities: Gardening, Nature walk, Fishing, Lawn Games

•

Games: Casino Night, Bowling, Bingo, Game Day, Wii, Cards, Uno Tournament, Puzzles,
Trivia, Riddles, Brain-Games, Scavenger Hunt, Murder Mystery, Scrabble, Yahtzee

•

Other Ideas: Magic Show, Manicures, Parades, Spa Day, Boat Ride, Music Festival,
Petting Zoo, Show and Tell, Sporting Event, Music Therapy, Reading Buddies, Mentors,
Charity Work/Volunteering, Music Concerts, Orchestras, Choir

Social Events: Movie Night, Coffee, Ice Cream, Fondue, Tea, Pizza Night, Bonfire, BBQ,
Potluck, Cultural Activities, Comedy Night, Costume Party, Holiday Party, Book Club,
Religious Groups, Bible Study, New Volunteer Welcome

Age Categories

•

Elementary (5-10): Uno Tournament, Puzzles, Scavenger Hunt, Costume Party, Sing
Along

•

Middle School (10-14): Game Day, Wii, Riddles, Yahtzee, Scrabble, Movie Night, BBQ,
Comedy Night, Cultural Activities, Book Club, Friendship Bracelets

•

High School (14-18): Cards, Brain-Games, Murder Mystery, Fondue, Bonfire, Poetry

•

College (18+): Casino Night, Trivia, Coffee, Tea, Potluck, Yoga, Share Recipes

•

All Ages: Ice Cream, Bingo, Bowling, Pizza Night, Holiday Party, Religious Groups, Bible
Study, New Volunteer Welcome, Karaoke, Theatre, Painting, Birdhouse, Watercolor,
Clay, Baking, Cookie Decorating, Tie Dye T-shirts, Sign Making, Card Making, Personal
Planters, Book Reading, Beadwork, Button Design Contest, Specialized Holiday
Activities, Knitting, Scrapbooking, Zumba/Dancing, Baseball, Balloon Badminton,
Noodle Ball, Walking, Exercise Classes, Healthy Cooking

Detailed Activity Descriptions:
Healthy Living/Exercise
Zumba/Dancing:
Description:
Items needed:
Directions:
				
				
				

Get blood flowing with some dancing (varies in intensity) to different music genres.
TV and a Zumba DVD or a Zumba instructor
Clear an area for a group of people to be able to move/dance in. Have the music/
DVD/instructor picked ahead of time. Before people arrive, make sure to inform
them about the activity so they can dress appropriately. Set up the technology and
enjoy this unconventional way to exercise. Make sure to take water breaks!

Yoga:
Description:
				
Items needed:
Directions:
				
				
				
				
				

Enjoy meditating as a group, indoors or outdoors, while simultaneously stretching
and warming up your muscles.
Mats/Thick Blankets
For this activity you can either have someone conduct a session or you can follow a
video. If you are having someone put their own session together, we recommend
looking up stretches/basic yoga moves from the Mayo Clinic or other health centers.
These stretches will work on all of the muscles throughout the body and are safe for
people of all ages and health statuses. Make sure everyone has some sort of
padding on the ground beneath them and enough space to stretch out in.

Baseball:
Description:
Items needed:
				
Directions:
				

Play a game of baseball or have your facility put a team together.
A ball (regular baseball or softer version), a hitting T (for people who may need
accommodations), and enough people
Play a game of baseball or watch a team of faculty/volunteers. Get into the spirit
with signs, food, and cheering.

Walking:
Description:
Items needed:
Directions:
			

Make socializing and exercise fun; pick a route and get your steps in for the day!
A good pair of shoes, a route in mind, and water
Pick ahead of time a route (can be indoor, outdoor, at facility or campus) and make 		
sure everyone is wearing proper attire. Plan for rest/water breaks!

Share Recipes:
Description:
				
				
Items needed:
Directions:
				
				

Everyone has a favorite recipe and there is more than likely a story that comes with
that food. Let’s put together a recipe book that can be used in cooking/baking
events or even in everyday settings!
Book, paper, and colored pens
Have people come prepared with a recipe or two that are their favorites. Put
together a recipe book that will be shared, while talking about the recipes/why it’s a
favorite/and what they associate the food with. Food is a great conversation starter!

Detailed Activity Descriptions
Healthy Living/Exercise (continued)
Healthy Cooking:
Description:
				
Items needed:
Directions:
				
				
				

Make eating healthy fun by learning new recipes as a group! Follow an instructor’s
directions in order to make a dish that you will be able to recreate later.
Recipe, ingredients, instructor, cooking supplies, and enough space
Have whoever will be running the session come up with a recipe ahead of time.
Make sure to limit the amount of people involved and get a head count before
this activity. Prep work should be done ahead of time. Have fun making a recipe and
then tasting it afterwards. Send everyone home with a copy of the instructions!

Noodle ball:
Description:
				
Items needed:
Directions:
				
				

This game is accommodating for all people (especially residents in memory care,
etc.) and it has been a huge hit at participating facilities!
Foam noodles (one for each participant) and blown up balloons (5 max.)
Give all the participants a noodle and have volunteers throw the balloons toward
them. Watch the fun unfold as the residents try to pass the balloons and keep them
off the floor with their noodles! Can be played sitting or standing.

Arts/Crafts
Karaoke:
Description:
Items needed:
Directions:
				
				

Enjoy some karaoke to your favorite songs!
Karaoke machine, YouTube, and a TV
Both YouTube and karaoke machines will need to be hooked up to a larger screen
(TV) for better viewing. Have many music options available, keep in mind the
generations of your participants. Collect music ahead of time.

Poetry:
Description:
Items needed:
Directions:
				
				
				

Learn to write and then share your poetry. This is a great way to learn a new hobby!
Paper, pencils, poem examples, and directions on how to write certain poem types
Gather together to learn about different types of poetry and how to write them.
Make sure to complete the prep work of types of poems, how to write poetry, and
examples for getting started ahead of time. Provide paper and writing utensils and
toward the end encourage sharing of the writings.

Theatre:
Description:
				
Items needed:
Directions:
				
				

Dabble in the art of theatre through attending a show in the community or putting
on one yourself.
Tickets if attending a performance, and a script/costumes if putting on a show
Depending on the participants decide whether attending a local performance would
be best or if they would enjoy putting on one themselves. This is a great way to get
involved with the community and to make new connections.

Detailed Activity Descriptions
Arts/Crafts (continued)
Painting:
Description:
Unleash your inner Van Gogh through painting classes. You can follow the
				
instructor’s directions or go freestyle!
Items needed: Paint, brushes, water in small cups, paper towels, plastic plates, example painting,
				and canvases
Directions:
Prepare the supplies for each participant, as they will need water/plates for their
				
paint/canvases/brushes/and paper towels. This is becoming a very popular activity
				
and can be relatively inexpensive as most of the supplies people have already. Look
				
into coupons or deals on canvases. Come up with the painting ahead of time, make
				
sure to paint it yourself so that they can have an example and you know what
				
instructions you will be giving.
Birdhouse:
Description:
				
Items needed:
Directions:
				
				
				
				
				

Learn to make birdhouses or even just decorate some already made ones. Provide
bird seed and see the gardens liven up with the colored birds.
Wood, paint, brushes, bird seed, potentially nails/glue if assembling a birdhouse
Decide whether your participants would enjoy building or painting birdhouses.
Depending on this, your materials will be different. If painting, look into Michael’s or
similar stores for already made birdhouses. Provide the paint, brushes, paper
towels, and birdseed. If creating birdhouses, look up easy birdhouses to build for
beginners. Get your supplies from a local craft store. Be sure to create an example
birdhouse for people to follow.

Watercolor:
Description:
Items needed:
Directions:
				

Go back to the basics and enjoy some watercolor painting!
Paper, watercolor paint, brushes, cups
Come up with a painting idea (or let people do whatever they want) and paint away!
Similar directions to “Painting.”

Clay:
Description:
Items needed:
Directions:
				

Make some sculptures or pottery
Clay, rolling pin, toothpicks
Provide the clay from a craft store and print out images of craft ideas. Provide a
rolling pin and some toothpicks for texture making.

Baking:
Description:
Items needed:
Directions:
				

Pick a recipe and bake away
Ingredients, recipe, access to baking materials
Let the residents and volunteers help you as you bake. Provide the materials and the
utensils. Suggestion: limit the number of people for this activity to save money.

Cookie Decorating:
Description:
Items needed:
Directions:
				

Decorate some cookies and then enjoy them as a snack
Sugar cookies, frosting, food coloring, knives, napkins, sprinkles
Mix the food coloring into frosting. Provide knives for application and sprinkles for
decoration.

Detailed Activity Descriptions
Arts/Crafts (continued)
Friendship Bracelets:
Description:
Make bracelets for your friends or yourself
Items needed: String, beads, tape, scissors, directions, examples of bracelets
Directions:
Provide directions and examples of different types of bracelets.
Tie Dye T-shirts:
Description:
Items needed:
Directions:

Create some cool t-shirt designs
T-shirts (or have people bring their own), dye, rubber bands
Print out directions on how to dye t-shirts and also designing tips.

Sign Making:
Description:
Items needed:
Directions:

Create posters for upcoming events (examples: sporting, fundraisers, etc.)
Poster paper, markers
Let the creativity flow and make some signs to spread awareness of the event.

Card Making:
Description:
Items needed:
Directions:
				

Create some cards that you will be able to send to a loved one
Paper, stamps, tape, markers, etc.
Gather some supplies and print off some examples of types of cards to create
(examples: birthday, anniversary, etc.).

Personal Planters:
Description:
Items needed:
Directions:
				

Create individual planters for your home
Pots, paint, dirt, seeds/plant
Decorate with paint, fill with dirt, and either put seeds or a plant in your new pot.
Make sure to water!

Button Design Contest:
Description:
Design your own button!
Items needed: Button holders, paper, writing utensils
Directions:
Create categories and come up with prizes for the winners. Have everyone design
				
his or her own button.
Scrapbooking:
Description:
Items needed:
Directions:
				
				

Create a scrapbook of some of your favorite memories
Paper, scrapbook, sticks, scissors, pens
Have people bring in some money to help cover funds. They should also supply their
own pictures. Everyone can work on their own or you can have residents team up
with guests to work on a scrapbook.

Knitting:
Description:
Items needed:
Directions:
				

Create items in this knitting group
Needles, yarn, directions, ideas, and a leader
Come up with ideas of items to create and some directions for them. Decide whether
you will supply the supplies or if it will be bring your own. Host a knitting group.

Detailed Activity Descriptions
Outdoor Activities
Gardening:
Description:
Items needed:
Directions:
				
				

Get some sunshine and work on the garden.
Garden, seeds, watering can, sticks
Plant flowers and/or vegetables in the garden! Write the plant’s name on the
popsicle stick and put it in the ground next to where you placed it. Make sure to
water and weed!

Nature walk:
Description:
Items needed:
Directions:

Go on a walk on a favorite trail or to a favorite spot.
Route idea, water, sunscreen, good shoes
Get some exercise by picking a destination and enjoying a walk in nature.

Lawn Games:
Description:
Items needed:
Directions:

Play ladder golf, corn hole, cricket, etc.
Games
Supply games and set them up outside.

Social Events
Movie Night:
Description:
Items needed:
Directions:

Pick a genre and enjoy some popcorn.
Movie, TV, popcorn, drinks
NA

Coffee/Tea/Ice Cream Socials:
Description:
Host a social of your choice.
Items needed: Whatever food/drink you picked
Directions:
Supply food/drinks of choice and chat with the participants
Fondue:
Description:
Items needed:
			
Directions:

Enjoy cheese or chocolate fondue.
Fondue pot, chocolate, cheese, items to dip (examples: bananas, marshmallows, 		
pretzels, etc.)
NA

Pizza Night:
Description:
Items needed:
Directions:

Let’s do pizza and movies!
Pizza, movie, TV, plates, napkins, drinks
NA

Bonfire:
Description:
Have guests over for a bonfire and roast some s’mores.
Items needed: Marshmallows, graham crackers, chocolate bars, sticks for roasting, wood, fire pit, 		
			chairs
Directions:
NA

Detailed Activity Descriptions
Social Events (continued)
BBQ:

Description:
Items needed:
Directions:
				

Enjoy some freshly grilled food.
Hot dogs, buns, condiments, hamburger, buns, plates, utensils, drinks
Try and get a headcount of how many people are going to attend. Then set up the
supplies and buy the food. Cook away!

Potluck:
Description:
Items needed:
Directions:

Team up with a resident and come up with a recipe to bring to the potluck.
Recipe, ingredients, etc.
Work in teams to cook and supply the food for the potluck.

Comedy Night:
Description:
				
Items needed:
Directions:
			

Everyone needs a good laugh so come enjoy a comedian and try out your own
material at the end of the event.
Comedian, chairs
Find a local or upcoming comedian who can come entertain. Let others bring their 		
own material and practice their own skills.

Holiday Party:
Description:
Items needed:
Directions:
				

Host a party!
(Depends on the holiday)
Halloween perhaps do a costume contest, Christmas do white elephant, Easter put
on an egg hunt, etc.

Book Club:
Description:
Items needed:
Directions:

Meet up to enjoy your book and bagels!
Book (picked by group leader) and snacks
NA

New Volunteer Welcome:
Description:
Host a gathering to welcome new guests, staff, and volunteers to the community.
Items needed: Snacks, drinks, chairs
Directions:
Meet and greet time, introduce the new members of team to the community. Host an
				
activity at this event to work on team bonding.
Games
Casino Night:
Description:
Items needed:
Directions:

Play some cards.
Cards, directions for those who don’t know how to play
Host your own casino night.

Bowling:
Description:
Items needed:
Directions:
				

Bowl in the comfort of the facility.
Large bowling set
Set up the pins down a hallway and take turns trying to knock them down. Have
someone keep track of score and set up the pins.

Detailed Activity Descriptions
Games (continued)
Bingo:
Description:
Items needed:
Directions:
Wii:

Play Bingo and win some prizes.
Bingo set, prizes
Get prizes from donation, dollar store, or use quarters.

Description:
Items needed:
Directions:
				

Play Wii bowling.
Wii, Wii sports, TV
If there are a lot of people have everyone gets two turns and you can bowl as a
team. Otherwise play regularly.

Cards:
Description:
Items needed:
Directions:

Play some card games.
Cards, directions for those who don’t know how to play
Come up with some favorite card games, print off directions, and then play.

Puzzles:
Description:
Items needed:
Directions:

Work as a team and figure out some jigsaws.
Puzzles
NA

Brain-Games/Riddles/Trivia:
Description:
Host some brain stimulating, team activities.
Items needed: Trivia material, riddles, and some brain games
Directions:
Buy a set or come up with your own material to host this event.
Murder Mystery:
Description:
Items needed:
Directions:

Somebody has been murdered and you have to find out who did it.
Murder mystery game
Read about this game before playing and provide some costumes (hat, glasses, etc.).

Scrabble/Yahtzee/Uno:
Description:
Have a game day or create some tournaments.
Items needed: Games
Directions:
Follow the directions for the games.
Other Ideas
Magic Show:
Description:
Items needed:
Directions:

Host a local magician and put on a magic show!
Magician
Watch as the residents and guests enjoy some hand tricks.

Spa Day:
Description:
Items needed:
Directions:

Have your very own spa day!
Nail polish, lotion, facemasks
Paint nails, give hand massages, and do facemasks with the residents.

Detailed Activity Descriptions
Other Ideas (continued)
Reading Buddies:
Description:
Items needed:
Directions:
				

Pair up residents and children to read some books.
Books, worksheets, markers
Take a few books and worksheets to go with the books and give them to residents
and their buddies. Have the children work on their reading/comprehension skills.

Charity Work/Volunteering:
Description:
Get some community service done by teaming up with people in the community.
				
Get volunteers to aid the residents in completing this activity.
Items needed: A charity or volunteer opportunity
Directions:
Team up with a charity in the community to do some volunteer work. Get volunteers
				
to help the residents put together backpacks for low income students, meals for
				
food shelf, etc.
Music Concerts/Orchestras/Choir:
Description:
Listen to beautiful music by talented musicians! This could be family members, high
				
school students, etc.
Items needed: Musician, instrument, large space
Directions:
Set up an area for the musician to play and get the word out. The more the merrier.
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